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Moodle uses the term "quizzes," but all of these instructions apply equally to tests and exams. For the 
most flexibility, we recommend using the following basic procedure: 

1. Create question "categories" (question pools or test banks). 

2. Add questions to your categories.  

3. Create a quiz shell and set options for how and when the quiz is deployed. 

4. Add questions from your categories to the quiz shell.  

Step 1: Create Question Categories (Pools) 

Setting up pools ("categories") for your questions makes it possible to: 1) select the questions you want 
for a particular test, 2) set up random blocks of questions in a test, 3) re-use questions in multiple tests, 
and 4) copy questions to another course. To create a category:   

1. Click on the admin gear in the upper right corner of your course home page, 
then click on More… 

2. In the Question bank 
area, click on the 
Categories link. 

3. In the Add category 
section of the next 
screen (see next page), 
make sure the Parent 
category displays 
"Default for [course 
name]."  
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4. Under Name, enter a title for the pool 
of questions (e.g., Chapter 1). (If you 
plan to add more than nine categories, 
name your pools 01, 02, etc. so that 
they will be listed in the correct order.) 

5. Click on Add category.  

6. Repeat steps 3-5 to create all of the 
pools you will need for your course.  

TIP: Be sure that Default for [course 
name] is selected as the parent 
category each time you add a category 
– Moodle sometimes tries to make the 
newest category the parent for your 
next one! 

Step 2: Add Questions to Categories 

You can add questions to Moodle in one of 
three ways:  

A. Import a publisher's test bank. 

B. Import a Word document in Aiken format. 

C. Create individual questions manually in Moodle. 

You can combine imported questions and manually created questions if you wish. 

A. Create a Test Bank from a Publisher 

Many publishers provide test banks that can be uploaded directly into Moodle. In other cases, they 
offer a test generator which you can download to create your own question pools. Exams created from 
test generators can be exported in Moodle or Blackboard format and then imported into Moodle. If 
the publisher only makes test banks available in Word format, see the next section of this guide. 

The following formats can be imported into Moodle: 

 Moodle XML 

 Blackboard (version 6 or higher) – A test bank saved in Blackboard format can often be 
successfully imported into Moodle. If you have trouble with this format, there are instructions 
to Troubleshoot Publisher Test Banks on the Moodle How-To's page. 

 Respondus – The CIS has a Respondus license and we'd be happy to help you out with 
importing test banks in this format—just give us a call. 

For test banks posted on the publisher's site, download the file(s) and save to your computer. If a 
single .zip file is provided, extract the files and save to your computer. See the instructions on page 6 to 
import the questions to your course. 

CAUTION: Allow several days' lead time to upload and create a quiz from a publisher’s test bank. 
Sometimes, the process is quite straightforward and painless, while other times…… it really isn’t! A 
lot depends on the individual publisher. Also, if you're creating pools with a test generator, do a trial 
run of the import process with the first pool you create to make sure that the questions import 
correctly. Note: Blackboard format nearly always works, if Moodle doesn't. 

https://support.sou.edu/index.php?/Knowledgebase/Article/View/53/8
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B. Create a Test Bank from a Word Document 

If you want to create a number of multiple choice or true/false questions, an easy way to post them in 
Moodle is to import them from a Word document using the Aiken format. If you need to add just a few 
questions, it's easier to create them directly in Moodle. Note: You must follow the formatting exactly 
as shown below in order for the import to work. We recommend importing a sample document with 
just two or three questions into Moodle to make sure the formatting is correct before drafting the 
entire document. The most common error in producing an Aiken formatted document is not using 
capitals letters for each answer choice or in the word "ANSWER." Note: Moodle will display questions 
in alphabetical order, not in the order they appear in your file. 

To create an Aiken-format file from scratch: 

1. Create a Word document and type each question as a single paragraph. Do not include a question 
number. Let the text wrap—press the [Enter] key only when you reach the end of the question. 

2. Introduce each answer choice with a single capitalized letter followed by a period or closing 
parenthesis and a space [A., B., C. or A), B), C)]. Press the [Enter] key just once after each answer 
choice. (See Turn Off Auto List Mode below if needed.) 

3. Introduce the correct answer with the word ANSWER in all capitals followed by a colon, one space 
and the capitalized letter corresponding to the correct answer (e.g., ANSWER: A). 

4. Insert one return (   ) between an ANSWER line and the following question. 

5. Save the document in UTF-8 format as described below. 

The following example of Aiken format demonstrates that you can use periods or parentheses for each 
answer choice. Note: True/False questions are treated as multiple choice, introduced with "A." and 
"B." (The ¶ symbols below are shown to indicate where hard returns should be placed. They will not 
actually be visible in your document unless you have Word set to display paragraph marks.)  

I want my students to perform a specific task. What element of Moodle should I 

use?¶ 

A) Discussion Forum¶ 

B) News Forum¶ 

C) Assignment¶ 

ANSWER: C¶ 

¶ 

Moodle is a product of Microsoft.¶  

A. True¶ 

B. False¶  

ANSWER: B¶ 

Turn Off Auto List Mode 

You may need to turn off Word's automatic 
bulleted list feature to format your file: 

1. Click on the File tab, then scroll way 
down and click on Options. 

2. Click on Proofing, then AutoCorrect 
Options…. 

3. On the AutoFormat As You Type tab, 
deselect Automatic bulleted lists. 
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4. On the AutoFormat tab, deselect Automatic bulleted lists, as well. 

5. Click on OK, then click on the Home tab to continue editing your document. 

Saving in UTF-8 Format 

After drafting your questions, you need to save your document in Plain Text UTF-8 format. This will 
ensure that your text will be read correctly when it is imported into Moodle.  

Saving in Plain Text UTF-8 using Word 

1. Click on the Office button or File tab and 
select Save As > Other Formats. 

2. Name your file to reflect its contents 
(e.g., chapter 1 pool). 

3. Under "Save as type," click on the pull-
down arrow and scroll down the list.  

4. Select Plain Text (*.txt) and click on Save. 

5. In the "Text encoding" dialogue box, 
select Other encoding. 

6. Select Unicode (UTF-8). 

7. Click on OK. 

 

Saving in Plain Text UTF-8 using Word for Mac 

1. Choose File, Save As. 

2. Name your file to reflect its contents (e.g., chapter 1 pool). 

3. From the "Format" drop-down menu, choose Plain Text (.txt). 

4. Click on Save.  

5. In the File Conversion screen, choose Other encoding (under Text encoding). 

6. In the box at right, scroll down (if necessary) and select Unicode 5.0 UTF-8. 

7. Click on OK. 

To create an Aiken file from an existing Word document: 

1. Follow the instructions above for saving the file as Plain Text UTF-8. This will shut off auto-
numbering and allow you to reformat the text as needed. 

2. Assess what needs to be adjusted in the text to convert it to Aiken format. Common adjustments 
include: removing extra paragraph returns 
between questions and possible answers, 
removing page headers and footers, 
substituting ANSWER for ANS, and 
capitalizing letters that introduce potential 
answers.  

3. Use "Find and Replace" wherever possible to 
make the necessary adjustments. For adding 
capital letters to responses, for instance, set 
the replace option to Match case and replace 
"a." with "A." To remove extra paragraph 
returns, replace ^p^p [two returns] with ^p. 
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4. Manually delete the number for each question. 
5. Review the file carefully, being especially mindful of the number of returns between questions and 

answers, as well as between questions. 
6. Save your work frequently and save once again in Plain Text format when ready. 

C. Create Individual Questions in Moodle 

If you have just a few questions to add, it's easiest to create them directly in Moodle. To manually 
create a question: 

1. Click on the admin gear in the upper right corner of your course home page, then click on More. 

2. In the Question bank area, click on the Questions link. 

3. From the pull-down menu at the top of the page, select the 
category where you wish to add questions (e.g., Chapter 1). 

4. Click on Create a new question.  

5. Select the type of question you wish to add and click on Next. (For 
information about question types, visit https://docs.moodle.org/ 
33/en/Question_types.) 

6. Enter the question and potential responses. While the fields 
provided will depend on the question type, here's an overview: 

 Question name. Assign your question a unique name (e.g., 
Essay1-1 for the first essay question in chapter 1).  
Note: Moodle stores questions in alphabetical order by question name. Students will not see the 
question name. 

 Question text. Enter the question in the Question text box. You can copy text from Word by 
using Ctrl+C and paste it with Ctrl+V. 

 Default Points. All questions have a default point value of 1. If all of the questions in a quiz will 
have the same value, you can control the number of points assigned to each question by 
changing the maximum number of points possible for the quiz. Moodle will scale the points up 
as necessary: a quiz with 20 1-point questions can be created with total maximum points of 50—
each question will count as 2.5 points when the quiz is graded by Moodle. 

 Feedback. Moodle provides multiple opportunities for feedback. For example, you can provide 
targeted feedback for each specific answer selected or general feedback for any wrong answer. 
You may leave the feedback fields empty. 

 For multiple choice questions:  

o Select 100% from the pull-down menu in the Grade field to identify the correct answer.  

o Check the Shuffle the choices box to display the answer choices in random order for each 
student, as long as the quiz itself is set to shuffle answer choices (see "Question Behavior" on 
p. 7). Be cautious about checking this option if any of the answer choices contain "All of the 
above," "None of the above," numbers or dates. For all or none of the above, answers can 
usually be revised to "All of these" or "None of these." In the case of numbers or dates, we 
recommend leaving these response options in numerical or chronological order rather than 
shuffling them. When you create the quiz settings, you'll have the opportunity to select 
random question order to ensure that every student takes a different version of the quiz. 

 Penalty points (advanced feature). Moodle allows you to apply penalty points to incorrect 
answers. If you don’t intend to assess penalty points for multiple attempts, you do not need to 
change the default value provided. The default quiz set-up does not assess penalty points.  

https://docs.moodle.org/33/en/Question_types
https://docs.moodle.org/33/en/Question_types
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7. Once you've entered the question and possible answers, scroll down and click on Save changes. 
Repeat steps 4-6 to add more questions manually. 

D. Import a Test Bank 

The process for uploading a test bank file is similar for files provided by a publisher and for Word 
documents saved in Aiken format. If you have not already created categories (see page 1), you should 
do so before taking these steps. 

1. Open the Question bank link (admin 
gear, then More…) and click on the 
Import tab. (If you still have the 
Question bank page open, click on 
the Import tab as shown here.) 

2. Select the File format that 
corresponds to your question 
bank. 

3. Open the General options 
area and use the Import 
category pull-down menu to 
select the test bank category 
where you wish to add your 
questions. Ignore the other 
settings in the General options 
area. 

4. Drag and drop your file into 
the file picker box or click on 
Choose a file…, browse for the 
file and click on Upload this 
file.  

5. Wait for the file to load—the 
file name will change from 
black to red when it's done 
uploading. 

6. Click on Import. If the process 
is successful, a list of 
questions will appear. For a 
file in Aiken format, if no 
questions or the incorrect number of questions appear, review your document to make sure you 
have correctly followed the formatting requirements. Be sure that: the question text doesn't 
include a paragraph return, answer choices all begin with a capital letter followed by a "." or ")", 
and the word "ANSWER" is in all caps (and correctly spelled!). 

7. Click on Continue at the bottom of the import confirmation page. (Or click on a different tab, then 
click back to the Import tab to bring in another test bank.) 

8. Repeat steps 2-7 for each additional pool, being careful to choose the correct category from the 
General options area each time. 

After you've uploaded your files, you can review all of the questions from a publisher's test bank. This 
article explains how. Be on the lookout for symbols that may have come across instead of apostrophes 
(e.g., ¥™). 

https://inside.sou.edu/assets/distanceeducation/docs/moodle/check-test-bank.pdf
https://inside.sou.edu/assets/distanceeducation/docs/moodle/check-test-bank.pdf
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Step 3: Create a Quiz 

Once you have created categories and populated them with questions, you're ready to create a quiz. 

1. With editing turned on, scroll to the section where you wish to 
conduct the quiz (e.g., Topic 3 or Week 3), click on the Add an 
activity or resource link. 

2. Select Quiz and click on Add.  
Note: After you create the quiz, to change any of the settings below, 
select Edit settings from the quiz administration menu. 

3. Provide a name for the quiz and use the Description textbox to provide instructions for your 
students. Here is an example of the type of information that can be included: 

This quiz is open book, open notes and covers Chapters 1, 2 and 3. You may take this quiz only once. Please 

review the instructions for taking tests in Moodle before taking this quiz and follow the instructions carefully. 

Click on the Attempt quiz now button (below) to begin the quiz. Open only when ready to begin. 

There are 5 pages with 5 questions each (total of 25 multiple choice questions). To move to the next page, click on 

the page number in the upper left column or on the Next button at the bottom of the page. 

When you have answered all of the questions, click on Submit all and finish. 

Note: Moodle will automatically display the description, any time limits, date restrictions, and the 
number of attempts allowed when students click on the quiz link. They cannot begin a quiz until 
the start date/time arrives. 

4. Set all quiz options as desired, paying special attention to the notes below. We've flagged the areas 

that you should be sure to set. Click on the Help icon  i  next to an item for more information. 

Timing 

 To set dates to open and/or close the quiz, check the Enable box(es) and select a date and time 
(keeping in mind that Moodle uses a 24-hour clock). Leave either or both Enable boxes unchecked 
to make the quiz available indefinitely. 

 Open and close dates determine when students may view the test questions and submit their 
responses. These dates do not determine whether students can see the link for the test and the 
test description. Visibility of the test link is controlled by "Common module settings" and 
"Restrict access" settings (see below). Access for students to the "Attempt quiz link" is controlled 
by the Timing settings. 

 Click on the Enable box in the Time limit field in order to control the amount of time students 
have to complete the quiz. (See Accommodating Students with Disabilities or Special 
Circumstances below to provide extensions to students.) 

 IMPORTANT! If you set a time limit for your test, make sure that the When time expires option 
is set to Open attempts are submitted automatically. This setting will ensure that students 
receive credit for the answers they have completed within the time allowed. 

Grade 

 Select a grade category for the quiz if you categorize graded items in your grade book. 

 Indicate how many times a student can take the quiz. If you allow multiple attempts, Moodle 
will record the highest score a student earns on the quiz by default. 

Layout 

 By default, quizzes will have five questions per page. This layout makes the test manageable for 
students and reduces the chances of a student's browser timing out.  

 If an essay question will likely take more than 10 minutes to answer, we recommend that you 
display only one essay question per page to minimize server timeout problems. 

https://support.sou.edu/index.php?/Knowledgebase/Article/View/65/9/students-taking-tests-in-moodle
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Question Behavior 

 Set Shuffle within questions to Yes if you want answer choices to appear in random order. 
Note: Choices will appear in random order only if the question itself is set to allow this. 

 Deferred feedback requires students to submit the entire quiz before they get any feedback on 
individual questions. Adjusting question behavior may result in effects that you don't anticipate, 
so we recommend using the default setting. 

Review options 

 Indicate what elements your students will see after they complete the quiz at three key points: 

1) immediately after they complete the quiz,  

2) later while the quiz is still open to others, and finally,  

3) when the quiz is closed.  

By default, students only see their score. The example above displays the default options until 
after the quiz closes, with additional information shown after the quiz closes. (See this article on 
setting review options for details.) 

 To expand review options, begin by checking the box for The attempt. This will allow you to 
check any of the other options.  

 Note: If you choose options for After the quiz is closed, be sure that a close date has been set in 
the Timings option area. 

Recommended Settings. For major exams, we suggest displaying only the score (Points) to 
students until after the quiz closes in order to discourage the sharing of questions and answers. We 
also recommend not displaying correct answers until after the quiz is closed, if at all.  

Appearance 

 These options are all advanced settings that can be ignored. 

Extra restrictions on attempts 

 A password is necessary if the test will be 
proctored (see related section on page 13). 
TIP: Choose a password that is not easily 
guessable and check the Unmask box to 
see the password as you type it.  

Overall feedback 

 If you'd like to provide general feedback to students on their scores, enter it in the textboxes 
provided, indicating the grade range to which you want each feedback message to apply.  

 Be sure you've selected Overall feedback in the Review options area to display the feedback. 

https://support.sou.edu/kb/articles/faculty-how-students-review-quiz-results
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Common module settings 

 If Availability is set to Show on course page, students will be able to view the quiz link on their 
course page and open it to read the quiz description. Remember, the test questions themselves 
will only be visible based on the open and close dates set in the Timing area.  

IMPORTANT! If this option is set to Hide from students, students will not be able to see the 
quiz, regardless of how the Timing and Restrict access options are set. It must be visible for 
students to take it. 

Restrict access 

 This section provides another way to control when students can access the quiz link. Unless you 
have a compelling need to control this quiz link, we recommend leaving this section blank and 
letting the quiz availability be determined by the Timing and Common module settings.  

Completion tracking 

 To track which students 
have taken the quiz, use 
the pull-down menu to 
select Show activity as 
complete when 
conditions are met. 

 Checking "Students 
must receive a grade…" 
will check the 
completion box after the quiz is submitted (unless there are essay questions that need to be 
manually graded). 

 If you check the "Require passing grade" option, you must also set the score for a passing grade 
for the quiz in the Grade option area above. 

5. Click on Save and display to add questions to the quiz shell. 

Note: You can change the quiz options at any time. 
To do so, open the quiz and click on Edit settings in 
the quiz admin gear or click on Edit, then Edit 
settings on the course main page.  

 

TIME SAVING TIP: When creating several quizzes, 
use the Duplicate icon to copy your quiz settings 
into additional quiz shells. Edit each new quiz to 
update instructions and availability dates as needed, 
then add questions as described below. 

Check Your Settings  

When you click on the quiz link, you can review the 
instructions you provided to students in the 
Description textbox. You'll also see information 
about how many attempts are possible, and any 
timing information that you selected. This is also 
what students will see when they click on the link. 
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Step 4: Add Questions to a Quiz 

Once the quiz settings are complete, you're ready to add questions to the quiz 
shell. To add questions, you need to edit the quiz.  

1. Open the quiz link, if necessary, then click on the admin gear, then on the 
Edit quiz link. 

2. On the Editing quiz page, click on Add to display your options for adding 
questions. 

 To add a NEW QUESTION to the quiz, click on + a new question, then 
follow the instructions on page 5 for 
creating a question from scratch.  

 To add SPECIFIC QUESTIONS to the 
quiz—recommended for midterms 
and final exams—click on + from 
question bank and select the desired 
category from the pull-down menu at 
the top of the dialogue box. 

Questions from the selected category 
will be displayed on your screen. Use 
the check box at the top of the 
column to select all of the questions 
or choose individual questions. (To 
preview a question, click on the 
magnifying glass icon on its right.) 
When you have chosen all of the 
questions you wish to add, click on 
Add selected questions to the quiz to 
return to the quiz canvas.  

 To add a RANDOM BLOCK of 
questions to the quiz—recommended 
for reading quizzes and routine tests 
with multiple attempts—click on + a 
random question and select the 
desired category from the pull-down 
menu at the top of the dialogue box. 

Use the pull-down menu to choose the 
number of random questions to add. Select 
up to 10 or multiples of 10 questions at a 
time. (You may need to add more than one 
random block in order to get the total 
number of questions you need, e.g., one 
batch of 10 plus a second batch of 5 for a 
total of 15 questions, but don't choose more 
questions than you have in the category!)  

Click on the Add random question button to 
add the questions to the quiz canvas. 
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3. Once you have selected questions, you'll be returned to the quiz canvas as shown below—specific 
questions in the image on the left, random questions on the right—where you can: 

  adjust the maximum grade (quizzes default to 100 points—see below) and Save, 

 Add new questions or select another question bank to pull in more questions, 

 drag and drop questions to reposition them,  

 delete a single question, 

 click on an insert page break icon to move questions to a new page, and 

 revise the points possible for any item.  

If you choose specific questions, select the Shuffle option if you wish. You can also edit an 
individual question or preview it. (You can edit a question at any time, even after students have 
taken a quiz.) 

Adjust Maximum Grade 

Regardless of the number of points assigned to each question, Moodle will automatically scale the 
value of each question up or down based on the Maximum grade setting. In these examples, the face 
value of the questions is 32, while the quiz itself is set for 100 points.  

To manually adjust the point value for an individual question, click on the pencil in the box next to the 
question, type in the new value, and click on [Enter]. 

Delete Questions 

If you need to remove questions from a 
quiz, click on the Select multiple items 
button. Next, select the specific 
questions you want to delete or click on 
the Select all link, then click on the 
Delete selected button.  

Preview Quiz & Verify Settings 

Click on the name of the quiz in the 
breadcrumb trail at the top of the page 
to open the quiz link. Click on Preview 
quiz now to see how your test will look 
to students. If you randomize your 
questions or use random blocks, preview 
it multiple times to see how it changes. 

Verify or change the quiz settings (e.g., time limit, open and close dates, etc.) by clicking on the quiz 
admin gear, then Edit settings. Click on Edit quiz to make changes to the questions. 
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Accommodate Students with Disabilities or Special Circumstances 

Moodle allows you to override quiz settings for individual students. For example, a student may need 
to take the quiz later than the rest of the class, or you may receive a faculty notification letter from 
Disability Resources informing you that a student needs additional time to take a test due to a 
documented disability. The quiz will remain off-limits to the rest of the class while it is available to the 
accommodated student. See these instructions for creating a quiz override. 

Note: Overrides must be applied to each quiz; they do not carry over from one quiz to another.  

View and Grade Quizzes 

When you create a quiz, a corresponding item is created in the grade book. Moodle will grade most 
question types as soon as a test is submitted and automatically enter the scores in the grade book. To 
view quiz results: 

1. Click on the link for the test in the 
course main page. You'll see the test 
description and the total number of 
attempts that have been made. 

2. Click on Attempts: # or click on the 
quiz admin gear, then Grades to view 
students' attempts.  

3. Click on a student's score to see the 
test as it was presented and submitted.  
Note: Students may flag questions as they take quizzes. Flags have meaning solely to them; flags 
don't affect quiz results in any way. 

Student View 

This image illustrates what a student 
might see after submitting a quiz. The quiz 
is time and date stamped, and the score is 
posted. If the review options set for the 
quiz allow students to see their attempt 
after they submit the quiz, there will be a 
Review link available to them as shown 
here. Note that students have a link that 
will take them Back to the course. 

Grade Essay Questions 

If your quiz contains essay questions, you will need to manually grade them. See Grade Quiz Items 
Manually for instructions. 

Clear a Quiz Attempt 

If a student experiences problems in 
submitting a test, follow these steps to 
clear the test attempt and allow a re-
take: 

1. Open the test link and click on the 
Attempts: # link (shown above).  

2. Check the box to the left of the 

https://support.sou.edu/kb/articles/faculty-tests-for-students-with-accommodations
http://sou.edu/distancelearning/pdf/manually-grade-quiz-items.pdf
http://sou.edu/distancelearning/pdf/manually-grade-quiz-items.pdf
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attempt associated with the student's name. (If necessary, click on Last name at the top of the 
column to sort attempts by last names.) 

3. Scroll down to the bottom of the table and click on the Delete selected attempts button.  

4. Click on Yes to confirm the deletion. 

Provide Instructions for Students 

Test taking instructions for students can be found in this Guide to Taking Tests in Moodle. We 
recommend that you include a link to this article in your course. Take a few minutes to review these 
instructions so that you become familiar with best practices for taking tests and can better assist your 
students. 

Note: If a student experiences a problem submitting a test, suggest using the Back button in the 
browser to return to the test and try to submit again. If the second attempt is not successful, you will 
need to clear the test attempt to allow the student to re-take the test. If the test contains many 
questions, note that there will likely be fewer problems if you ensure that the quiz is set to display no 
more than one essay question or five other questions per page. 

Administer a Proctored Exam 

If you wish to have an exam proctored for your students, Moodle offers solutions for managing the 
process as well as administering the test itself. Students may take the exam at a proctored site or with 
an online proctoring service such as ProctorU. This article explains how to conduct a proctored exam. 

Learn More 

You'll find articles and troubleshooting advice for quizzes on the Moodle How-To's page. For 
assistance, contact the Center for Instructional Support. 

https://support.sou.edu/kb/articles/students-taking-tests-in-moodle
https://support.sou.edu/kb/articles/faculty-administer-a-proctored-exam
https://inside.sou.edu/cis/moodle.html#quizzes

